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Chapter 149

Equivalence Tests for
the Difference of Two
Within-Subject CV’s
in a Parallel Design
Introduction
This procedure calculates power and sample size of equivalence tests for the difference of within-subject
coefficients of variation (CV) from a parallel design with replicates (repeated measurements) of a particular
treatment. These tests are based on the TOST methodology. This routine deals with the case in which the statistical
hypotheses are expressed in terms of the difference of the within-subject CVs, which is the standard deviation
divided by the mean.

Biosimilarity
Two treatments are said to be biosimilar if both their means and their variances are equivalent. The equivalence of
their variances may be established by comparing their coefficients of variation.

Technical Details
This procedure uses the formulation first given by Quan and Shih (1996). The sample size formulas are given in
Chow, Shao, Wang, and Lokhnygina (2018).
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 is the response in the ith group or treatment (i = 1, 2), jth subject (j = 1, …, Ni), and kth measurement
(k = 1, …, M). The simple one-way random mixed effects model leads to the following estimates of CV1 and CV2
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Testing Equivalence
The following hypotheses are usually used to test for the equivalence of two group CVs
𝐻𝐻0 : |𝐶𝐶𝑉𝑉1 − 𝐶𝐶𝑉𝑉2 | ≥ 𝐷𝐷0 versus 𝐻𝐻1 : |𝐶𝐶𝑉𝑉1 − 𝐶𝐶𝑉𝑉2 | < 𝐷𝐷0.

The two one-sided test statistics used to test this hypothesis is
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where D0 is the hypothesized CV difference under the null hypothesis and
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T is asymptotically distributed as a standard normal random variable.
𝜎𝜎�𝑖𝑖∗2 =

Hence the null hypothesis of non-equivalence is rejected if 𝑇𝑇− < 𝑧𝑧𝛼𝛼 or 𝑇𝑇+ > 𝑧𝑧1−𝛼𝛼 .

Power

The power of this combination of tests is given by (see Julious (2010) page 15)

where
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where Φ(𝑥𝑥) is the standard normal CDF.
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A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary
sample size.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
non-equivalent CVs when in fact the CVs are equivalent.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Often, a value of 0.025 is used for one-sided tests (such as this).
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
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•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

149-4
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Equivalence Tests for the Difference of Two Within-Subject CV’s in a Parallel Design
•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled. Since the sample sizes are the same in
each group, this value is the value for N1, and also the value for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 4. You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
M (Measurements Per Subject)
Enter one or more values for M: the number of repeated measurements made on each subject.
You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.
The range is M ≥ 2.

Effect Size (CV = Coefficient of Variation)
D0 (Equivalence Difference)
Enter one or more values for D0. D0 is sometimes called the Margin of Equivalence. It is the largest distance
above or below CV2 which will still result in the conclusion of equivalence. As long as the absolute difference is
between these two values, the difference is not large enough to be of practical importance.
CV (coefficient of variation) is the within-subject standard deviation divided by the mean.
The range of D0 is D0 > 0.
Syntax
You can enter a single value such as 0.3, a list of values such as 0.1 0.2 0.3, or a range of values such as 0.2 to 0.9
BY 0.1.
D1 (Actual Difference)
Enter one or more values for the actual difference (CV1-CV2). Hence, this is the difference at which the power is
calculated.
CV (coefficient of variation) is the within-subject standard deviation divided by the mean.
D1 is in the same scale as D0 and CV2.
D1 can be any number, positive, negative, or zero. Usually, D1 is between –D0 and D0.
You can enter a single value such as 0.3, a list of values such as 0.0 0.1 0.2 0.3, or a range of values such as 0.0 to
0.9 BY 0.1.
CV2 (Group 2 Coef of Variation)
Enter one or more values for within-subject coefficient of variation (CV2) in group 2. It is used to define CV2 for
both H0 and H1.
CV is the within-subject standard deviation divided by the mean.
Although, strictly speaking, CVs can be negative since means can be negative, we assume that CVs are positive
(> 0).
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that its within-subject CV is
non-inferior to a reference drug. A parallel design with 2 repeated measurements per subject will be used.
Company researchers set the significance level to 0.05, the power to 0.90, CV2 to 0.4, D0 to 0.2, and D1 to -0.1 0.05 0 0.05 0.1. They want to investigate the range of required sample size values assuming that the two group
sample sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Within-Subject CV’s in a Parallel Design
procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.9
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
M (Measurements Per Subject) .............. 2
D0 (Equivalence) .................................... 0.2
D1 (Actual Difference) ............................ -0.1 -0.05 0 0.05 0.1
CV2 (Group 2 Coef of Variation) ............ 0.4

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
TOST Hypotheses: H0: |CV1 - CV2| ≥ D0 vs. H1: |CV1 - CV2| < D0

Actual
Power
0.9019
0.9034
0.9047
0.9001
0.9012

Grp 1
Grp 2
Sample Sample
Size
Size
N1
N2
83
83
43
43
36
36
60
60
164
164

N
166
86
72
120
328

Meas
Per
Subj
M
2
2
2
2
2

Grp 2
CV
CV2
0.400
0.400
0.400
0.400
0.400

Lower
Equiv
Bndry
CV1.L
0.200
0.200
0.200
0.200
0.200

Upper
Equiv
Bndry
CV1.U
0.600
0.600
0.600
0.600
0.600

Equiv
Margin
D0
0.200
0.200
0.200
0.200
0.200

Actual
Diff
D1
-0.100
-0.050
0.000
0.050
0.100

Alpha
0.050
0.050
0.050
0.050
0.050

References
Quan, H. and Shih, W.J. 1996. 'Assessing reproducibility by the within-subject coefficient of variation with
random effects models'. Biometrics, 52, pages 1195-1203.
Chow, S.C. 2014. Biosimilars Design and Analysis of Follow-on Biologics, Third Edition. Taylor & Francis/CRC.
Boca Raton, Florida.
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
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Report Definitions
TOST Hypotheses: H0: |CV1 - CV2| ≥ D0 vs. H1: |CV1 - CV2| < D0
Power is the probability of rejecting a false null hypothesis.
N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
M is the number of measurements per subject.
CV2 is the within-subject coefficient of variation in group 2 assumed by both H0 and H1.
CV1.L is the lower equivalence boundary. CVs between CV1.L and CV1.U are considered equivalent (similar).
CV1.U is the upper equivalence boundary. CVs between CV1.L and CV1.U are considered equivalent (similar).
D0 is the equivalence margin |CV1 - CV2|.
D1 is the actual difference (CV1 - CV2) at which the power is calculated (assumed by H1).
Alpha is the probability of rejecting a true null hypothesis, H0.
Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to test the equivalence (or similarity) of a particular group (group
1) compared to a reference group (group 2) with regards to their within-subject coefficients of
variation (CVs). Group sample sizes of 83 and 83 achieve 90% power to reject the null
hypothesis that the |CV difference| is greater than the equivalence limit of 0.200 at a
significance level of 0.050. The TOST testing procedure is being used. The CV of group 2 is
0.400. The difference in CV at which the power is calculated is -0.100. Each subject is
measured 2 times.

This report gives the sample sizes for the indicated scenarios.
Note that the required sample sizes are not symmetric about D1 = 0. This is because the variances are based on
D1 and so they are different depending on whether D1 > 0 and D1 < 0. For example, if D1 = 0.1, the value of
CV1 used to calculate the power will be 0.5. However, if D1 = -0.1, the value of CV1 used to calculate the power
will be 0.3. Since the power equations use CV1 in the computation of the variance, these two values of D1 will
result in different power values.

Plot Section

This plot shows the relationship between sample size and D1.
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Example 2 – Validation using Hand Calculations
We could not find a validation example in the literature, so we will present calculations by hand. Chow et al.
(2018) page 203 presents the following formula for the direct calculation of sample size

𝑁𝑁1 = 𝑁𝑁2 =

�𝑧𝑧1−𝛼𝛼 + 𝑧𝑧

1−

2

𝛽𝛽 �
2

(𝜎𝜎1∗2 + 𝜎𝜎2∗2 )

(𝐷𝐷0 − |𝐶𝐶𝑉𝑉1 − 𝐶𝐶𝑉𝑉2 |)2

Suppose CV2 = 0.7, D0 = 0.2, D1 = 0, M = 2, alpha = 0.05, and power = 0.9. The sample size is found to be
(1.645 + 1.645)2 (0.3626 + 0.3626)
= 196.2 ≈ 197.
𝑁𝑁1 = 𝑁𝑁2 =
(0.2 − |0|)2

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Within-Subject CV’s in a Parallel Design
procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.9
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
M (Measurements Per Subject) .............. 2
D0 (Equivalence) .................................... 0.2
D1 (Actual Difference) ............................ 0
CV2 (Group 2 Coef of Variation) ............ 0.7

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
TOST Hypotheses: H0: |CV1 - CV2| ≥ D0 vs. H1: |CV1 - CV2| < D0

Actual
Power
0.9014

Grp 1
Grp 2
Sample Sample
Size
Size
N1
N2
197
197

N
394

Meas
Per
Subj
M
2

Grp 2
CV
CV2
0.700

Lower
Equiv
Bndry
CV1.L
0.500

Upper
Equiv
Bndry
CV1.U
0.900

Equiv
Margin
D0
0.200

Actual
Diff
D1
0.000

Alpha
0.050

The sample size matches the hand calculations.
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